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●●● CARACTERISTIQUES DU PRODUIT ●●● 
 
 

Ce LECTEUR est un centre multimédia basé sur un réseau qui, 
grâce à un disque dur intégré à haute capacité de 3,5 pouces, 
est capable de lire divers fichiers multimédias (comme des films, 
des MP3, des photos, etc.) sur une télévision et, s’il est 
connecté à un PC, est également capable de lire des films 
partagés via le réseau. 
·Lecteur MPEG multi-codec  
·Jukebox numérique  
·Album photo numérique  
·Réseau domestique 10/100M  
·Sortie analogique et numérique  
Lecture USB Host  
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●●● MESURES DE SECURITE ET AUTRES INSTRUCTIONS●●● 

 
N’utilisez le produit qu’après avoir pris connaissance des instructions suivantes.  
Veuillez accorder une attention toute particulière aux avertissements. 
  
>>> Copyrights  
Le logiciel, les fichiers audio et vidéo, ainsi 
que les propriétés intellectuelles sont 
protégés par un copyright et des lois 
internationales.  
La reproduction et la distribution du contenu 
relatif à ce produit sont la responsabilité de 
l’utilisateur. 
 
>>> Vérification du codec  
Ce produit ne prend pas en charge tous les 
formats de codecs multimédia. Vérifiez les 
types de codecs disponibles. Par ailleurs, 
même avec un codec pris en charge, 
certains fichiers ne peuvent pas être lus en 
raison de la propriété du fichier ou de 
l’environnement système. 
  
>>> Sauvegarde de données 
Conservez une sauvegarde des données 
stockées dans ce produit en un lieu sûr. 
Nous ne sommes aucunement responsable 
quant à la perte ou à l’endommagement des 
données.  
 
>>> Chute / Choc  
Ne cognez pas et ne laissez pas tomber le 
produit. Cela pourrait entraîner un problème 
majeur. 
 
>>> Corps étranger  
N’insérez aucun objet métallique (comme 
une pièce, une épingle à cheveux, etc.) ni 
aucune substance étrangère inflammable à 
l’intérieur du produit. Cela pourrait 

endommager le circuit ou provoquer un 
incendie.  
 
>>> Démontage / Modification  
N’essayez pas de démonter ou de modifier 
un composant du produit. Cela pourrait 
entraîner un problème plus grave et toute 
modification du produit risque d’annuler la 
garantie.  
>>> Charge 
Evitez de déposer des objets lourds sur 
l'appareil. Cela pourrait endommager le 
produit ou entraîner une blessure. 
  
>>> Produits chimiques  
Ne nettoyez pas le produit avec des produits 
chimiques ou des détergents. Cela risque 
d’endommager la surface du produit. 
  
>>> Eau / Humidité  
Ne mettez pas ce produit en contact avec 
de l’eau ou un liquide. Cela peut engendrer 
une décharge électrique ou un incendie. 
Dans le cas ou un liquide pénètre dans le 
produit, mettez-le hors tension et 
débranchez immédiatement le câble 
d'alimentation. 
  
>>> Aimant ou propriétés magnétiques 
Ne placez pas le produit à proximité d’un 
objet doté d’un puissant champ magnétique. 
Cela risque d’entraîner un 
dysfonctionnement du produit ou 
d’endommager les données stockées.  
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>>> Chaleur 
Ne placez jamais le produit à la lumière 
directe du soleil ou à proximité d'une source 
de chaleur. Ne conservez pas le produit à 
une température élevée pendant une longue 
durée.  

>>> Vue / Ouïe 
Ne regardez pas la télévision et ne 
maintenez pas un son trop élevé pendant 
une trop longue durée. Cela peut entraîner 
un trouble de la vue ou de l’audition. 

>>> Incendie 
Lorsque vous utilisez le produit, si vous 
détectez de la fumée ou une odeur 
anormale, mettez le produit hors tension, 
débranchez immédiatement l’adaptateur et 
contactez le service après-vente. 
  
>>> Enfants 
Ne laissez pas les enfants toucher le produit. 
Ils pourraient se blesser. 
 

>>> Puissance 
N’utilisez pas plusieurs produits 
électroniques sur une seule prise. Insérez 
fermement la prise. Au cours de l’utilisation, 
ne débranchez pas le produit inutilement. 
Après avoir utilisé le produit, mettez-le hors 
tension et débranchez l’adaptateur. 
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●●● SPECIFICATIONS DU PRODUIT ●●● 

 
 

Codec  MPEG1/2/4, DivX, XviD, WMV9 (max 1920*1080) Vidéo  
Format  WMV, AVI, MPG, DAT, VOB, IFO, ISO, TP, TRP, 

TS 
 

Audio MP3, WMA, AAC, WAV, AC3, DTS down mixing/Pass 
through 

Co
de

c p
ris

 en
 

ch
ar

ge
  

Photo JPEG  
Sortie 
vidéo  

Composite, S-Vidéo  
HDMI (480p, 576p, 720p, 1080i, 1080p) 
Composant (480i (576i), 480p (576p), 720p, 1080i) 

Sortie 
audio  

Analogique (Stéréo), Coaxial, Optique (5.1 ch) 

Rése
au  

10/100 Mbits/s  

Co
nn

ex
ion

s 
 

Interfa
ce 
USB  

2 ports USB 2.0 Host (concentrateur USB pris en charge) 

Systè
me de 
fichier
s du 
disqu
e dur  

FAT32/NTFS  

Type 
de 
disqu
e dur 

Disque dur 3,5 pouces SATA et IDE 

Dime
nsion
s  

187 mm (L) x 193 mm (H) x 60 mm (P) 

Temp
ératur
e  

0-60  

Gé
né

ra
lité

s 

Adapt
ateur 
secte
ur 

12 V 3,5 A CA/CC Adaptateur tension libre (CA 100-240 V, 
50-60 Hz) 
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●●●CONTENU & DESCRIPTION DU PRODUIT●●● 
LECTEUR/Télécommande/Batterie/Câble A/V/Adaptateur/Câble d’alimentation/CD/Manuel 
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●●● DESCRIPTION DES PIECES ●●● 
 
1. Fenêtre du mode d’affichage LCD 
Le mode d’affichage actuel du LECTEUR s’affiche dans cette fenêtre. 
2. Voyant de connexion sans fil 
Il s’allume lorsque la connexion sans fil est établie 
3. Voyant de connexion au réseau local 
Il s’allume lorsque la connexion au réseau local est établie 
4. Voyant de fonctionnement du disque dur 
Il s’allume lorsque le disque dur est utilisé 
5. Voyant de connexion USB 
Il affiche la connexion du câble au périphérique USB.  
6. Récepteur du signal de la télécommande  
Ce capteur reçoit des signaux de la télécommande. Utilisez le contrôleur prévu à 
cet effet. 
Ne bloquez pas ce capteur 
7. Voyant d'alimentation 
Il s’allume lorsque l’appareil est sous tension.  
8. Bouton de marche/arrêt 
Mise sous/hors tension. 
9. Bouton de configuration 
Permet d’entrer et de sortir du menu de configuration 
10. Bouton Stop 
Il sert à arrêter la lecture en cours. 
11. Bouton Play (Lecture) 
Il permet de lire un fichier sélectionné.  
12. Bouton OK 
Il permet de sélectionner un menu ou de lire un fichier sélectionné.  
13. Borne d’entrée de l’alimentation 
Branchez l’adaptateur fourni à cette borne (12 V CC/3,5 A) 
14. Port USB HOST 
Il est possible de connecter un disque dur externe, un lecteur de disque optique, un 
Memory Stick, etc., à ce port. 
15. Port de connexion du câble du réseau local 

Le câble du réseau local se branche sur ce port. 
16. Borne de la sortie vidéo HDMI 
Un câble HDMI est branché à cette borne : le produit peut être connecté à une TV 
numérique au moyen d’un câble HDMI. 
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17. Borne de sortie audio numérique coaxiale 
Vous pouvez profiter d’un son canal 5.1 en connectant le produit à une enceinte Home 
Cinéma ou à un récepteur en utilisant un câble coaxial. 
18. Borne de sortie audio numérique optique  
Vous pouvez profiter d’un son canal 5.1 en connectant le produit à une enceinte Home 
Cinéma ou à un récepteur en utilisant un câble optique. 
19. Borne de sortie vidéo S-Vidéo 
Pour se connecter à une télévision, branchez le câble S-Vidéo à cette borne. 
20. Borne de sortie vidéo composante 
Un câble composante vidéo avec une borne rouge, bleue et verte est connecté à cette 
borne. Lorsque vous utilisez cette connexion, la sortie TV du lecteur doit être définir 
pour être prise en charge par votre télévision. 
21. Borne de sortie vidéo composite 
Pour se connecter à une télévision, branchez le câble composite à cette borne. 
22. Borne de sortie audio stéréo 
Ces bornes servent à la sortie vidéo analogique. 
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●●● INSTALLATION DU DISQUE DUR ●●● 

Veuillez installer le lecteur en respectant les instructions suivantes. 
 

 
  
1. Appuyez simultanément sur les boutons latéraux et faites glisser le support du disque dur.     
2. Ajustez correctement le support avec le disque dur.   
3. Branchez le câble SATA et le câble d’alimentation. 
4. Ajustez les deux bandes en plastique pour empêcher le disque dur de bouger. 
5. Faites glisser le support du disque dur et vérifiez que les boutons s’insèrent bien dans les 
trous.  
6. OK 
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7. Appuyez simultanément sur les boutons latéraux et faites glisser le support du disque dur.     
8. Ajustez correctement le support avec le disque dur.   
9. Branchez le câble SATA et le câble d’alimentation. 
10. Ajustez les deux bandes en plastique pour empêcher le disque dur de bouger. 
11. Faites glisser le support du disque dur et vérifiez que les boutons s’insèrent bien dans les 
trous.  
12. OK 
 

 
 

●●●Partage de données en réseau avec un PC●●● 
 
1. Connexion du câble LAN entre le LECTEUR et un PC 

1
.1 Connexion à un ordinateur    
Vous pouvez utiliser n’importe quel câble pour la connexion (un câble direct ou croisé) 
Conseil : Si vous avez déjà une carte LAN connectée à Internet, vous pouvez 
ajouter une carte LAN supplémentaire pour connecter le LECTEUR à 
l’ordinateur.  
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1.2 Connexion via un concentrateur (or un routeur Internet) 
Pour la connexion à un concentrateur ou un routeur Internet, utilisez un câble direct, 
branchez le port LAN du LECTEUR à un port LAN du concentrateur ou du routeur 
Internet via un câble LAN. 
 
Remarque :  
Afin d’être relié au LECTEUR, un ordinateur (portable) doit disposer d’une carte LAN 
10/100 Mbits/s. Vous pouvez utiliser un câble LAN croisé ou direct pour effectuer le 
branchement. Vous pouvez acheter l’un de ces câbles via les boutiques en ligne ou 
dans un magasin informatique près de chez vous. 
 
 
2. Partage de données en réseau avec un PC  
Après avoir effectué le branchement du câble LAN, réglez la mise en réseau 
Windows, selon votre environnement système, de la manière suivante : 
Pour établir la communication réseau entre le LECTEUR et votre PC, il convient de 
remplir, en général, deux exigences : 

1) Le partage des dossiers et la configuration de la sécurité  
2) L’utilisation de la même adresse IP et du masque de sous-réseau 

 
 
 
 
 
 
 
2.1 Configuration du partage des données pour Windows 98/SE/ME  

1. Sélectionnez un dossier que vous souhaitez partager et sélectionnez le 
menu « Sharing » (Partage) en utilisant le bouton droit de la souris.  
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2. Cochez « Sharing » et saisissez « Nom du dossier partagé. EX mes 
films »  

AVERTISSEMENT !  
1) « Nom du dossier partagé » ne peut pas dépasser 12 caractères. 
2) Définissez le type d’accès en Read-only (Lecture seule).  
3) Ne communiquez pas vos mots de passe.  
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3. Si le dossier est partagé, vous verrez une main dans l’icône du dossier.    
              Mes films  

 
4. Dans « Control Panel-Network » (Panneau de configuration-Réseau) et 

sélectionnez « TCP/IP-LAN card name » (TCP/IP-nom de la carte LAN) 
parmi les éléments affichés. 

 
Avertissement  
Vous trouverez le nom de la carte LAN sous « Device Manager—Network 
Adapter » (Gestionnaire de périphériques - Adaptateur réseau). 
 

 
5. Après avoir coché « Specify an IP address » (Préciser une adresse IP), 

saisissez votre adresse IP et le masque de sous-réseau. Ensuite, cliquez 
sur OK. 
Ex. Adresse IP : 192.168.1.3 
Masque de sous-réseau : 255.255.255.0  

 
AVERTISSEMENT !  
Si votre PC a déjà coché « Obtain IP address automatically » (Obtenir 
automatiquement l’adresse IP) et que l’IP est automatiquement attribuée à partir 
d’un routeur Internet ou d’un serveur DHCP, vous ne devez pas effectuer ce 
réglage. 
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Si vous souhaitez configurer l’IP, veuillez obtenir une adresse IP disponible et 
un masque de sous-réseau auprès du fabricant du routeur ou du fournisseur 
de service DHCP.  
 

 

 
 

6. Configurez l’environnement réseau du LECTEUR. Après avoir appuyé sur 
le bouton « SETUP » (Configuration), sélectionnez « IP SETUP » 
(Configuration IP) parmi les éléments de configurations « NETWORK » 
(Réseau), ainsi que l’adresse IP et le masque de sous-réseau. 
Ex. Adresse IP : 192.168.1.10  
Masque de sous-réseau : 255.255.255.0  

 
Après avoir procédé à la configuration, sauvegardez la valeur configurée en appuyant 
à nouveau sur le bouton « Setup ».  
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 AVERTISSEMENT ! 
Si l’adresse IP de votre PC est automatiquement attribuée par un routeur 
Internet ou un serveur DHCP, vous ne devez pas effectuer ce réglage. Dans ce 
cas, définissez « IP SETUP » sur Auto. Ensuite, l’IP sera automatiquement 
attribuée.  
 
Si vous souhaitez une configuration manuelle, veuillez obtenir une adresse IP 
disponible et un masque de sous-réseau auprès du fabricant du routeur ou du 
fournisseur de service DHCP.  
 
 
2.2 Configuration du partage de données pour Windows 2000  

1. Sélectionnez un dossier que vous souhaitez partager et sélectionnez le 
menu « Sharing » (Partage) en utilisant le bouton droit de la souris. 

 
 

2. Cochez « Sharing » et saisissez « Nom du dossier partagé ». Ex. Mes 
films  

 
AVERTISSEMENT !  
« Nom du dossier partagé » ne peut pas dépasser 12 caractères.  

3.  Dans l’écran ci-dessus, cliquez sur « Permissions » et vérifiez qu'un 
compte « Everyone » (Tout le monde) existe. Sinon, ajoutez-en un en cliquant 
sur le bouton « Add » (Ajouter.  
 

Remarque : Définir les permissions pour permettre la lecture.  
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4. Si le dossier est partagé, vous verrez une main dans l’icône du dossier.  

Mes films 
5.  Dans « Control Panel—Administrative Tools—Computer 
Management—Local Users and Group » (Panneau de configuration-Outils 
administratifs-Utilisateurs locaux et Groupe) et, parmi les éléments qui 
s’affichent, double-cliquez sur l’élément Guest (Invité). 
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6.  Après avoir coché « User cannot change password » (L’utilisateur ne peut 
pas modifier le mot de passe) et « Password never expires » (Le mot de 
passe n’expire jamais), ne cochez pas les autres cases. Cliquez ensuite sur 
« OK ». 
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7. Dans « Control Panel—Network and Dial up Connections » (Panneau de 
configuration – Réseau et connexions) Sélectionnez « Local Area 
Connection » (Connexion au réseau local) et ouvrez la fenêtre de propriété en 
utilisant le bouton droit de la souris et en sélectionnant « Properties » 
(Propriétés). 

 
AVERTISSEMENT ! 
S’il existe plus de deux « Connexions au réseau local », sélectionnez une 
carte LAN qui est connectée au LECTEUR.  

 
 
 
 

 
 

8. Parmi les éléments affichés, double-cliquez sur « Internet 
Protocol(TCP/IP) ». 
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9. Après avoir coché « Specify an IP address » (Préciser une adresse 
IP), saisissez votre adresse IP et le masque de sous-réseau. Cliquez ensuite 
sur « OK ». 

Ex. Adresse IP : 192.168.1.3 
Masque de sous-réseau : 255.255.255.0 

 



Hard Disk Multimedia Player QH100                                 

                                                       - 19 - 

  

 

 
AVERTISSEMENT ! 
Si votre PC a déjà coché « Obtain IP address automatically » (Obtenir 
automatiquement l’adresse IP) et que l’IP est automatiquement attribuée à 
partir d’un routeur Internet ou d’un serveur DHCP, vous ne devez pas 
effectuer ce réglage.  
Si vous souhaitez une configuration manuelle, veuillez obtenir une adresse 
IP disponible et un masque de sous-réseau auprès du fabricant du routeur 
ou du fournisseur de service DHCP. 
 
10. Configurez l’environnement réseau du LECTEUR. Après avoir appuyé sur le 
bouton « Setup » (Configuration), sélectionnez les éléments et définissez-les en 
configuration manuelle. Ensuite, saisissez votre adresse IP et le masque de 
sous-réseau.  

Ex. Adresse IP : 192.168.1.10  
Masque de sous-réseau : 255.255.255.0  

Après avoir procédé à la configuration, sauvegardez la valeur configurée en 
appuyant à nouveau sur le bouton « Setup ». 

 
 
 
 

2.3 Configuration du partage des données pour Windows XP 
1. Sélectionnez un dossier que vous souhaitez partager et sélectionnez le 
menu « Sharing and security » (Partage et sécurité) en utilisant le bouton droit 
de la souris. 
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2. Cochez « Sharing this folder on the network » (Partager ce dossier sur le 
réseau) et saisissez « Share Name » (Nom du dossier de partage).  

 Mes films 
 

AVERTISSEMENT !  « Nom du dossier partagé » ne peut pas dépasser 12 
caractères.  
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3. Si le dossier est partagé, vous verrez une main dans l’icône du dossier. 

Mes films 
4.  Dans « Control Panel—Administrative Tools—Computer 
Management—Local Users and Group » (Panneau de configuration-Outils 
administratifs-Utilisateurs locaux et Groupe) et, parmi les éléments qui 
s’affichent, double-cliquez sur l’élément Guest (Invité).  

AVERTISSEMENT ! 
1. Le réglage de la permission est uniquement requis pour les utilisateurs 
de Windows XP Pro. Si vous utilisez XP Home, allez directement au point 6. 
2. Si vous ne voyez pas « Administrative Tools » (Outils 
d’administration), cliquez sur « Switch to Classic View » (Basculer en 
mode classique) dans le coin gauche.  

 

 
 

5.  Après avoir coché « User cannot change password » (L’utilisateur ne peut 
pas modifier le mot de passe) et « Password never expires » (Le mot de passe 
n’expire jamais), ne cochez pas les autres cases. Cliquez ensuite sur « OK ». 
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6. Dans « Control Panel—Network Connections » (Panneau de configuration – 
Connexions réseau). Sélectionnez « Local Area Connections » (Connexions au 
réseau local). Sélectionnez « Local Area Connection » (Connexion au réseau 
local) et ouvrez la fenêtre de propriété en utilisant le bouton droit de la souris et 
en sélectionnant « Properties » (Propriétés). 

 
AVERTISSEMENT ! 
1. Si vous ne voyez pas « Network connections » (Connexions réseau), cliquez 
sur « Switch to Classic View » (Basculer en mode classique) dans le coin  
supérieur gauche.  
2. S’il existe plus de deux « Connexions au réseau local », sélectionnez une 
carte LAN qui est connectée au LECTEUR. 
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7. Parmi les éléments affichés, double-cliquez sur « Internet Protocol 
(TCP/IP) ». 

 

 
 

Après avoir coché « Specify an IP address » (Préciser une adresse IP), saisissez 
votre adresse IP et le masque de sous-réseau. Cliquez ensuite sur « OK ». Ex. 
Adresse IP : 192.168.1.3 Masque de sous-réseau : 255.255.255.0. 
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AVERTISSEMENT ! 
Si votre PC a déjà coché « Obtain IP address automatically » (Obtenir 
automatiquement l’adresse IP) et que l’IP est automatiquement attribuée à 
partir d’un routeur Internet ou d’un serveur DHCP, vous ne devez pas effectuer 
ce réglage. 
 
Si vous souhaitez une configuration manuelle, veuillez obtenir une adresse IP 
disponible et un masque de sous-réseau auprès du fabricant du routeur ou du 
fournisseur de service DHCP. 

Dans l’écran suivant, cliquez sur l’onglet « Advanced » (Avancé). Si l’option 
« Internet Connection Firewall » (Pare-feu de la connexion Internet) est cochée, 
désactivez cette option.  

Remarque  
Si vous utilisez Service pack2, consultez l’illustration ci-dessous. 
 
Dans la section « Windows Firewall » (Pare-feu Windows), cliquez sur « Settings » 
(Paramètres). 

 
 

Après avoir sélectionné « Off » (Désactivé), cliquez sur OK. 
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8. Configurez l’environnement réseau du LECTEUR. Après avoir appuyé sur le 
bouton « SETUP » (Configuration, sélectionnez « IP SETUP » (Configuration IP) 
parmi les éléments de configurations « NETWORK » (Réseau) et définissez une 
configuration manuelle. Ensuite, saisissez votre adresse IP et le masque de 
sous-réseau. 

 Ex. Adresse IP : 192.168.1.10  
Masque de sous-réseau : 255.255.255.0. 

 
 
Un ordinateur ne peut pas reconnaître un disque dur non formaté. Si votre PC 
n’est pas encore formaté, veuillez le formater en suivant les instructions 
suivantes. En général, lorsque vous achetez un nouveau disque dur, il n’est 
pas formaté. 
1) Connectez le LECTEUR à votre PC via le câble LAN.  
2) Dans « Start- Control Panel- Administrative Tools—Computer Management » 

(Démarrer – Panneau de configuration – Outils d’administration – Gestion de 
l’ordinateur) et sélectionnez « Disk Management » (Gestion du disque). 
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3) Si « Disk Signature » (Signature du disque) et « Upgrade Wizard » (Assistant de 

mise à niveau) apparaissent, cliquez sur « NEXT » (Suivant). 
4) Sélectionnez le nouveau disque dur et cliquez sur « Next » (Suivant). 
5) Lorsque l’assistant a terminé, cliquez sur « Finish » (Terminer). 
6) Dans « Disc Management » (Gestion du disque), sélectionnez le nouveau 

disque dur non attribué et cliquez sur « New Partition » (Nouvelle partition) en 
utilisant le bouton droit de la souris. 
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●●● Configuration de la partition du disque et Format 

(Win2000/XP) ●●● 
 

1. Si le « New Partition Wizard » (Assistant de la nouvelle partition) est exécuté, 
cliquez sur « Next » (Suivant). 

 
 

2. Cochez « Primary Partition » (Partition primaire) et cliquez sur « Next » 
(Suivant). 

 
 

3. Après avoir entré une taille de partition en Mo, cliquez sur « Next » (Suivant). 
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4. Si une lettre est attribuée au nouveau disque dur, cliquez sur « Next » 
(Suivant). 

 

5. Dans « Format this partition with the following setting  » (Formater cette 
partition avec la configuration suivante), définissez le « File System » (Système de 
fichiers) sur FAT32 et cochez « Perform a quick format » (Effectuer un formatage 
rapide). Cliquez ensuite sur « Next » (Suivant). 
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6. Si [Completing the New Partition Wizard] (Terminer l’assistant de la nouvelle 
partition) apparaît, cliquez sur [Finish] (Terminer).  
7. Désormais, une partition du LECTEUR (Formaté en FAT32) est créée. A 
l’étape suivante, une partition NTFS sera créée. 
8. Dans « Disc Management » (Gestion du disque), sélectionnez la partie non 
attribuée du disque et cliquez sur « New Partition » (Nouvelle partition) en utilisant 
le bouton droit de la souris. 

 
9. Si le « New Partition Wizard » (Assistant de la nouvelle partition) est exécuté, 
cliquez sur « Next » (Suivant).  
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10. Cochez « Primary Partition » (Partition primaire) et cliquez sur « Next » 
(Suivant).  

      
  

11. Dans la case « Partition Size in MB » (Taille de la partition) en Mo, conservez 
la taille actuelle et cliquez sur « Next » (Suivant). (La taille par défaut indique la 
partie restante non allouée du disque). 



Hard Disk Multimedia Player QH100                                 

                                                       - 32 - 

 
 

12.  Si une lettre est attribuée au nouveau disque dur, cliquez sur « Next » 
(Suivant).  

 
 

13. Dans « Format this partition with the following setting  » (Formater cette partition 
avec la configuration suivante), définissez le « File System » (Système de fichiers) sur 
NTFS et cochez « Perform a quick format » (Effectuer un formatage rapide).  
Cliquez ensuite sur « Next » (Suivant).  
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14. Si [Completing the New Partition Wizard] (Terminer l’assistant de la 
nouvelle partition) apparaît, cliquez sur [Finish] (Terminer).  

 

Avertissement :  
Un disque formaté en NTFS peut uniquement être reconnu par un système 
Windows 2000 ou XP. Il ne peut pas être reconnu dans un système Windows 98 ou 
ME, si vous avez créé un système de fichiers FAT32. Ne cochez pas « Enable file 
and folder compression » (Permettre la compression des fichiers et des dossiers). 
Dans un système Windows 2000 ou XP, si vous créez un système de fichiers FAT32, 
vous ne pouvez pas attribuer une lettre d’un disque à un disque dur de plus de 
32 G. (Un système NTFS unique est recommandé). Si vous souhaitez créer une 
partition FAT32 simple, utilisez un système Windows 98 ou ME. Par ailleurs, si 



Hard Disk Multimedia Player QH100                                 

                                                       - 34 - 

vous divisez un disque dur de plus de 40 G en plusieurs partitions, définissez-les 
en « Primary Partition » (Partition primaire). Une partition étendue ne sera pas 
reconnue.  
 
●●●Installation du câble de connexion ●●● 
 
１、Connexion avec une sortie TV (Composite) ordinaire  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2、Connexion avec une sortie S-Vidéo 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Connectez le lecteur et votre 
TV en utilisant le câble vidéo 
jaune. Allumez le lecteur et le 
téléviseur. Sélectionnez le 
mode de sortie approprié sur 
votre TV jusqu’à obtenir 
l’écran initial du lecteur. 

Branchez le lecteur à votre TV 
au moyen du câble S-Vidéo. 
Mettez le lecteur et la TV sous 
tension, sélectionnez le mode 
d’entrée vidéo approprié sur 
votre TV jusqu’à obtenir 
l’écran initial du lecteur. 
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3、Connexion avec une sortie HDMI 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4、Connexion avec une sortie Composante 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Branchez le lecteur à votre 
TV au moyen du câble 
composante. Mettez le 
lecteur et la TV sous 
tension. Sélectionnez le 
mode d’entrée vidéo 
approprié sur votre TV 
(mode d’entrée 
composante dans ce 
cas-ci). 

Branchez le lecteur à votre 
TV au moyen du câble HDMI, 
mettez le lecteur et la TV 
sous tension, confirmez que 
votre TV est en mode HDMI, 
définissez le lecteur en mode 
HDMI en appuyant à 
plusieurs reprises sur le 
bouton « TV out » de la 
télécommande jusqu’à ce 
que l’image apparaisse.  
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5、Connexion avec 2 canaux d’une TV normale 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5、Connexion avec une sortie Coaxiale 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Branchez la sortie 
sonore gauche 
(blanche) et droite 
(rouge) à la borne 
appropriée de votre TV 
ou de votre chaîne 
Hi-Fi. 

Lorsque vous disposez d’un 
décodeur/amplificateur à 
plusieurs canaux, vous 
pouvez profiter d’une haute 
qualité canal 5.1 via un câble 
coaxial.  L’illustration 
ci-dessus montre la manière 
de brancher le câble coaxial. 
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6、Connexion avec une sortie optique 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
7、Connexion à un ordinateur 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Branchez le lecteur à l’ordinateur au 
moyen d’un câble USB. Les données 
seront transférées du PC au lecteur. 
L’ordinateur doit être mis sous tension 
et le nouveau lecteur sera coché sur le 
PC sans devoir installer le pilote sur 
Windows ME/2000/XP. (Windows 98 
doit installer le pilote contenu sur le CD 
fourni). 

Lorsque vous disposez d’un décodeur/amplificateur à canaux multiples doté d’une 
sortie optique, vous pouvez profiter d’une haute qualité sonore 5.1 via un câble 
optique. L’illustration ci-dessus montre la manière de brancher le câble optique.
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●●●Télécommande ●●● 
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 Bouton de marche/arrêt 
Permet d'allumer ou d'éteindre l'appareil.  
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 Mode disque local  
Permet de basculer en mode Disque local  

 Mute (Sourdine)  
Permet de couper le son  

 Play/Pause (Lecture/Pause)  
Lance ou met en pause la lecture d’un film, de fichiers musicaux ou images.  

 OK  
Sélectionne un élément du menu ou un fichier à lire.  

 Volume  
Réglage du volume  

Raccourci vers l’écran d’accueil  
Permet de se rendre au menu de l’écran d’accueil du LECTEUR  
1 clic : Page de sélection de la partition pour chaque mode  
2 clics : Permet de se rendre au menu de l’écran d’accueil du LECTEUR.  

 Search (Recherche)  
Recherche vers l’avant ou vers l’arrière (Chaque clic permet de doubler la vitesse de 
la recherche : 2, 4, 8, 16, et 32 vitesses).  

 Subtitle (Sous-titres)  
Permet de régler le paramètre de sous-titres.  

1 clic :  
Modifie la taille des sous-titres (après avoir modifié la taille en utilisant la flèche 
HAUT et BAS, appuyez sur le bouton OK).  

2 clics :  
Modifie la couleur des sous-titres (après avoir modifié la couleur en utilisant la flèche 
HAUT et BAS, appuyez sur le bouton OK).  

3 clics :  
Sélectionne des sous-titres multiples (Lorsqu’un fichier de sous-titres contient plus 
de deux langues, appuyez 3 fois sur le bouton et sélectionnez la langue des 
sous-titres grâce à la flèche HAUT et BAS. Ensuite, appuyez sur le bouton OK). 

Remote Controller 
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 Audio 
Sélectionne une source audio spécifique lorsque le fichier vidéo comprend plusieurs 
sources audio.  
 

 Zoom avant / zoom arrière 
Permet de faire un zoom avant ou un zoom arrière à l’écran.  
1 clic (zoom avant à l’écran). 
Permet de personnaliser un niveau de zoom en utilisant les touchés fléchées (mis en 
œuvre à l’avenir). 
2 clics (Pan & Scan) (Recadrer). 
Remplit l’écran en se basant sur le ratio horizontal d’un fichier vidéo (mais une partie 
du côté gauche et droit de l’image est perdue). 
3 clics (plein écran). 
Remplit l’écran quel que soit le format d’image d’un fichier.  
4 clics (écran par défaut). 
Règle l’écran en fonction du format d’image original du fichier.  

 
 Sélection du mode de lecture  

Sélectionne un mode de lecture des fichiers musicaux ou vidéo (voir les descriptions 
des icônes ci-dessous).  
 

 répétition d’une chanson       répétition illimitée  

1 seule lecture        lecture aléatoire  

 répétition illimitée de tous les fichiers  

 répétition aléatoire illimitée de tous les fichiers  

1 seule lecture de tous les fichiers  

1 seule lecture aléatoire de tous les fichiers  

lecture répétée illimitée d’un seul fichier  
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Bookmark (Signet)  
Permet de marquer une position au milieu de la lecture (Utilisez le bouton Bookmark 
(signet) pour vous rendre à un endroit désiré marqué par un signet).  

Mode réseau PC  
Bascule en mode de recherche sur le réseau du PC.  

Affichage de la condition de la télécommande  
Lorsque l’on appuie sur une touche, un voyant rouge s’allume pour indiquer 
l’utilisation de la télécommande.  

LANG 

 Grâce à ce bouton, vous pouvez choisir votre langue parmi plusieurs langues. 
Mode USB HOST  

Permet de basculer en mode USB HOST.  

SETUP (Réglage)  
Permet de passer à l’écran du menu Réglage.  

FUNC 
Lorsque vous définissez le wi-fi avec un mot de passe de cryptage, vous pouvez 
choisir le statut d’entrée adéquat en appuyant sur cette touche. Appuyez une fois 
pour modifier le statut d’entrée de chiffres arabes en majuscules et appuyez deux 
fois pour modifier le statut d’entrée de majuscules en minuscules. 

Touches de saisie de chiffres/caractères  
Sert à saisir des chiffres et des caractères pour divers éléments et options du menu. 
Permet de se rendre rapidement à un emplacement de fichier spécifique en 
parcourant les fichiers ou les modes.  

GOTO (Aller à)  
Permet de passer à la position désirée lors de la lecture.  
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STOP  
Sert à arrêter la lecture en cours ou à revenir à un dossier précédent.  

Touches fléchées 
 
Servent à naviguer et à sélectionner des éléments du menu. Lors de la lecture d’un 
film, effectuez les actions suivantes. 
Haut/Bas : Modifier la position d’un sous-titre 
Gauche/Droite 
Film : Recherche vers l’avant ou vers l’arrière sur la lecture en cours. 
Musique : Avance vers l’avant/arrière de 15 secondes. 
 

 SYNC  
Lorsqu’un film n’est pas en synchronisation avec les sous-titres, utilisez cette touche 
pour les synchroniser. Chaque pression permet d’ajuster la synchronisation d’une 
seconde. 

 

SKIP (saut)  
Permet de passer au fichier suivant en cours de lecture. Lorsque l’on utilise cette 
touche sur un écran de liste de fichiers, il avance vers l’avant/arrière vers différentes 
pages.  

TITLE (titre)  
Permet d’accéder au menu des titres lors de la lecture d’un DVD.  

MENU  
Permet d’accéder au menu lors de la lecture d’un DVD.  

INFO  
Permet d’afficher les informations d’un fichier en cours de lecture.  

Multi Angle (multi angle)  
Permet de modifier l’angle de la caméra lors de la lecture d’un DVD. Uniquement 
pour les titres multi angle.  

Mode de sortie TV  
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Modifie le mode de sortie TV selon l’ordre suivant (NTSC Composite -> NTSC 
Component -> NTSC HDMI -> PAL Composite -> PAL Component ->PAL HDMI)  

Picture (Image)  
Permet de régler la luminosité, le contraste et la couleur. Sélectionne une propriété 
d’image selon l’ordre suivant : (Luminosité -> Contraste -> Couleur) Modifie la 
valeur de chaque propriété en utilisant les flèches gauche et droite.  

 
 
 

●●● Réglage du menu Configuration ●●● 
 

L’illustration ci-dessous montre l’écran de Configuration du LECTEUR  
 

 
 

Pour chaque élément du menu, les options possibles sont expliquées ci-dessous.  

 
1. SYSTÈME  
 
TV OUT (sortie TV)  

C/S-Video : Signaux vidéo via la borne de sortie composite et S-Vidéo  



Hard Disk Multimedia Player QH100                                 

                                                       - 45 - 

Composante : Signaux vidéo via la borne de sortie composante (4 résolutions 
possibles : 480i (576i), 480p (576p), 720p, et 1080i)  
HDMI : Signaux vidéo via la borne de sortie HDMI (4 résolutions possibles : 480p 
(576p), 720p, 1080i, 1080p)  

TV Type (Type de TV) 
4:3 Letterbox (4:3 boîte aux lettres)  
Ce format d’image permet d’afficher le contenu sur base de sa longueur 
horizontale. Des barres horizontales noires sont placées par le lecteur au-dessus 
en en dessous de l’écran à afficher dans un mode large.  
4:3 Pan Scan (4:3 Recadré)  
Ce format d’image permet d’afficher le contenu sur base de sa longueur verticale. 
Il remplit l’écran, mais une certaine partie du côté gauche et droit de l’image est 
perdue.  

16:9 sortie d’image au format d’image 16:9. 
Audio Output (Sortie audio) 

Sortie audio analogique 2 canaux 
Numérique encodé  
Signaux audio numériques via la borne de sortie optique ou coaxiale (pas de sortie 
analogique). 
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2. PROGRAMME 

 
Language selection (Sélection de la langue) 
Affiche la langue sélectionnée. Permet de choisir une langue parmi le coréen, l’anglais, 
l’espagnol, etc. 
Size Selection (Sélection de la taille) 
Permet de sélectionner une taille de sous-titres parmi petits sous-titres, grands 
sous-titres et aucun sous-titre. 
Color Selection (Choix des couleurs)  
Permet de sélectionner une couleur de sous-titres parmi Noir/Blanc, Jeune/Noir, 
Vert/Noir, Blanc/Bleu, Jaune/Bleu et Vert/Bleu.  
Slideshow Duration (Durée du diaporama) 
Permet de définir la durée du diaporama.  
Initialize (Paramètres par défaut)  
Rétablit tous les réglages par défaut. 
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3. Réseau 

 
Wired / Wireless (Câblé/sans fil) : 

Câblé : 
Définition de l’IP 
Réglage automatique :  
Attribue automatiquement une adresse IP à partir d’un routeur Internet 
ou d’un serveur DHCP.  
Réglage manuel :  
Attribue un réglage de l’IP 

Sans fil : 
Sélectionne le point d’accès 
Clé de cryptage : utiliser, ne pas utiliser, annuler 
Utiliser : Veuillez saisir une clé de 10 caractères (mode WEP de 64 bits). 
(Type d’authentification : Mode WEP : ouvert, partagé, auto et WPA. 

Mode : TKIP, AES) 
Réglage automatique :  
Attribue automatiquement une adresse IP à partir d’un routeur Internet 
ou d’un serveur DHCP.  
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Réglage manuel :  
Attribue un réglage de l’IP 

 
1. Accédez à l’interface de configuration et à l’utilisation de la télécommande 
de la manière suivante : 
Mettez le lecteur sous tension, appuyez sur « > » pour accéder à l’option 
« Configuration » puis appuyez sur OK. 
2. Configuration du réseau sans fil. Utilisez la télécommande de la manière 
suivante : 
Appuyez sur la touche « bas » pour accéder aux options réseau, appuyez deux 
fois sur « > », appuyez sur « bas » et « ok » pour accéder à l’interface de la 
configuration sans fil. Choisissez le réseau local sans fil disponible. 
3. Cryptage 
Si vous ne souhaitez pas de cryptage Web, appuyez sur « OK » pour choisir 
cryptage « non utilisé », sinon, appuyez sur la touche « haut » pour atteindre 
l’option « utiliser » et appuyez sur « < », veuillez saisir vos clés de cryptage de 
10 caractères. Vous pouvez supprimer des caractères avec la touche 
« stopback » et modifier les chiffres en utilisant les touches « haut » et « bas ». 
Appuyez sur « OK » pour sauvegarder le cryptage.   
Lorsque le mode de configuration de l’IP s’affiche à l’écran, choisissez « auto » 
si vous souhaitez rechercher automatiquement l’adresse IP disponible, sinon, 
choisissez « manuel » pour configurer l’adresse IP comme vous le souhaitez. 
4. Appuyez sur « OK ». 
5. Sortez, ensuite, vous pouvez choisir les ressources disponibles du réseau. 
Exit (Quitter) 

Permet de quitter le menu Configuration. 
 
Avertissement : UTILISATION DE NTSC.PAL 
 
EX. NTSC : COREE, ETATS-UNIS, JAPON, CANADA, ETC. 
PAL :EUROPE, MOYEN-ORIENT, HONG-KONG, ETC. 
 

 



Hard Disk Multimedia Player QH100                                 

                                                       - 49 - 

Mettez le lecteur sous tension et sélectionnez le mode TV OUT en appuyant sur la 
touche « TV Out » de la télécommande (NTSC Composite -> NTSC Composante -> 
NTSC HDMI -> PAL Composite -> PAL Composante ->PAL HDMI)  

 
●●● Ecran Menu principal ●●● 

 
L’illustration ci-dessous montre l’écran principal du LECTEUR 

 

 
 
Icônes et composants de l’écran  
 
1. Sélection du disque dur  
Si vous sélectionnez l’icône de sélection du disque dur, le LECTEUR va rechercher et 
afficher tous les disques de votre système local. Utilisez également cette icône pour 
rechercher le disque dur du LECTEUR. Après avoir sélectionné un disque, vous 
pouvez lire un fichier multimédia.  
2. Sélection du PC en réseau  
Si vous sélectionnez l’icône de sélection du PC partagé, le LECTEUR va rechercher 
et afficher tous les PC qui contiennent des dossiers partagés sur votre réseau local. 
Référez-vous à [Partage de données en réseau] pour de plus amples détails 
concernant la configuration du partage de données.  
3. Sélection du disque USB  

MAIN Menu Screen  
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Si vous sélectionnez l’icône de sélection du disque USB, le LECTEUR va rechercher 
et afficher les périphériques USB connectés via un port USB HOST. Vous pouvez lire 
un fichier multimédia à partir d'un disque dur externe, d'un stick de mémoire, etc.  
 
 

●●● Lecture de film ●●● 
 
Le LECTEUR est capable de lire les fichiers suivants : AVI, MPG, MPEG, DAT, VOB, 
TP, TRP, WMV, ISO etc. L’ordre et la méthode de lecture sont déterminés par la 
sélection d’un mode de répétition. 
 
Touches et fonctions pour la lecture de films 
 

Touches de la 
télécommande 

Fonction Description 

1 clic Modifie la taille des sous-titres (après avoir modifié la 
taille en utilisant la flèche HAUT et BAS, appuyez sur le 
bouton OK). 

2 clics Modifie la couleur des sous-titres (après avoir modifié 
la couleur en utilisant la flèche HAUT et BAS, appuyez 
sur le bouton OK). 

SUBTITLE 
(Sous-titres) 

3 clics Sélectionne des sous-titres multiples (Lorsqu’un fichier 
de sous-titres contient plus de deux langues, appuyez 
3 fois sur le bouton et sélectionnez la langue des 
sous-titres grâce à la flèche HAUT et BAS. Ensuite, 
appuyez sur le bouton OK. 

AUDIO Sélection 
audio 
multiple 

Sélectionne une source audio spécifique lorsque le 
fichier vidéo comprend plusieurs sources audio. 

INFO Affichage 
des 
information
s sur le 
fichier 

Permet d’afficher les informations d’un fichier en cours 
de lecture. 

BOOKMARK 
(Signet) 

Lecture 
continue 

Prend deux types en charge : les points d’arrêt et les 
signets (jusqu’à 9) 

Touches de la 
télécommande  

Fonction Description 

VOL (Volume) Réglage du 
volume 

Réglage du volume 
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MUTE 
(Sourdine) 

Son en 
sourdine 

Permet de couper le son 

1 clic Permet de personnaliser un niveau de volume via les 
touches fléchées. 

2 clics Pan & Scan 
3 clics Remplit l’écran quel que soit le format d’image d’un 

fichier. 

ZOOM 

4 clics Règle l’écran en fonction du format d’image original du 
fichier. 

SYNC Affichage 
et timing 
des 
sous-titres 

Lorsqu’un film n’est pas en synchronisation avec les 
sous-titres, utilisez cette touche pour les synchroniser. 
Chaque clic permet d’ajuster la synchronisation d’une 
seconde. 

GOTO (Aller à) Saut 
instantané 

Permet de passer à la position désirée lors de la 
lecture. Après avoir saisi une valeur via les touches 
fléchées ou les touches numériques, appuyez sur OK. 

OK Lecture 
d’un fichier 
sélectionné 

Lecture d’un fichier sélectionné. 

Haut/Bas Modifie la position d’un sous-titre. TOUCHES 
FLECHEES Gauche/Dr

oite 
Recherche vers l’avant ou vers l’arrière sur la lecture 
en cours. 

PLAY (Lecture) Lecture/Pa
use 

Permet de lancer la lecture ou de la mettre en pause. 

Arrêt Permet d’arrêter la lecture en cours. STOP (Arrêt) 
Dossier 
précédent 

Permet de déplacer le dossier du niveau supérieur 
dans une liste de fichiers.  

Fichier 
suivant/pré
cédent 

Permet de passer au fichier suivant ou précédent au 
cours de la lecture. 

SKIP (saut) 

Page 
suivante/pr
écédente 

Lorsque l’on utilise cette touche sur un écran de liste 
de fichiers, il avance vers l’avant/arrière vers 
différentes pages. 

SEARCH 
(Rechercher) 

Recherche 
rapide 

Recherche vers l’avant ou vers l’arrière (Chaque clic 
permet de doubler la vitesse de la recherche : x2, 4, 8, 
16 et 32). 
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●●● Lecture de fichiers musicaux ●●● 

 
Lors de la lecture de fichiers musicaux, le système est en mode de lecture musicale. 
Pendant la lecture de fichiers musicaux, vous pouvez rechercher des dossiers et des 
fichiers. Après avoir sélectionné un nouveau fichier et appuyé sur OK, le fichier 
sélectionné sera lu. 
 
Touches et fonctions pour la lecture de fichiers musicaux  
 

Touches de la 
télécommande  

Fonction Description 

BOOKMARK 
(Signet) 

Lecture continue Prend deux types en charge : les points 
d’arrêt et les signets (jusqu’à 9) 

VOL (Volume) Réglage du volume Réglage du volume. 
MUTE 
(Sourdine) 

Son en sourdine Permet de couper le son. 

OK Lecture d’un fichier 
sélectionné 

Lecture d’un fichier sélectionné. 

PLAY 
(Lecture) 

Lecture/Pause Permet de lancer la lecture ou de la mettre 
en pause. 

Arrêt Permet d’arrêter la lecture en cours. STOP (Arrêt) 
Dossier précédent Permet de déplacer le dossier du niveau 

supérieur dans une liste de fichiers. 
Fichier 
suivant/précédent 

Permet d’arrêter la lecture en cours. SKIP (saut) 

Page 
suivante/précédente 

Lorsque l’on utilise cette touche sur un 
écran de liste de fichiers, il avance vers 
l’avant/arrière vers différentes pages. 

Haut/Bas Navigation entre les fichiers lors de la 
lecture.  

TOUCHES 
FLECHEES 

Gauche/Droite Avance vers l’avant/arrière de 15 secondes. 
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●●● Lecture de fichiers photo ●●● 

 
Il est possible de lire des fichiers JPG. Le LECTEUR dispose également d’une 

fonction de diaporama. La durée d’affichage de chaque image peut être réglée,  en 
quelques secondes, dans le menu Réglages. Lorsque vous sélectionnez 0 second 
(0 seconde), le système affiche une image spécifique jusqu’à ce que vous appuyez 
sur la touche SKIP (saut) ou STOP. 

 
Touches et fonctions pour la lecture de photos 

Touches de la 
télécommande 

Fonction Description 

ANGLE Rotation de l’image Permet d’effectuer une rotation de 
l’image de 90 degrés dans le sens des 
aiguilles d’une montre. 

OK Lecture d’un fichier 
sélectionné 

Lecture d’un fichier sélectionné. 

PLAY (Lecture) Lecture/Pause Permet de lancer la lecture ou de la 
mettre en pause. 

Arrêt Permet d’arrêter la lecture en cours. STOP (Arrêt) 
Dossier précédent Permet de déplacer le dossier du niveau 

supérieur dans une liste de fichiers. 

fichier 
suivant/précédent 

Permet de passer au fichier suivant en 
cours de lecture. 

SKIP (saut) 

Page 
suivante/précédente 

Lorsque l’on utilise cette touche sur un 
écran de liste de fichiers, il avance vers 
l’avant/arrière vers différentes pages. 

1 clic Permet de personnaliser un niveau de 
volume via les touches fléchées. 

2 clics Pan & Scan 
3 clics Plein écran 

ZOOM 

4 clics Format d’image original 
SYNC Réglage de la 

durée 
Permet de régler la durée du diaporama. 

 



Hard Disk Multimedia Player QH100                                 

                                                       - 54 - 

 
●●● DVD virtuel ●●● 

 
DVD virtuel est une fonction qui extrait le contenu d’un DVD, sauvegarde le contenu 
sur le disque dur et lit le contenu sauvegardé comme si vous lisiez ce même DVD. 
Grâce à cette fonction, vous pouvez éviter d’endommager des disques originaux et 
facilement lire des films sans devoir changer de disque. 
 
Touches et fonctions du DVD virtuel  

Touches de la 
télécommande 

Fonction Description 

INFO Affichage des 
informations sur le 
fichier 

Permet d’afficher les informations d’un 
fichier en cours de lecture. 

VOL (Volume) Réglage du volume Réglage du volume 

MUTE (Sourdine) Son en sourdine Permet de couper le son 

GOTO (Aller à) Saut instantané Permet de passer à la position désirée 
lors de la lecture. Après avoir saisi une 
valeur via les touches fléchées ou les 
touches numériques, appuyez sur OK. 

Lecture/OK Lecture/Pause Permet de lancer la lecture ou de la 
mettre en pause. 

Arrêt Permet d’arrêter la lecture en cours. STOP (Arrêt) 
Dossier précédent Permet de déplacer le dossier du niveau 

supérieur dans une liste de fichiers. 
Fichier 

suivant/précédent 
Permet de passer au fichier suivant en 

cours de lecture. 
SKIP (saut) 

Page 
suivante/précédente 

Lorsque l’on utilise cette touche sur un 
écran de liste de fichiers, il avance vers 
l’avant/arrière vers différentes pages. 

SEARCH 
(Rechercher) 

Recherche rapide Recherche vers l’avant ou vers l’arrière 
(Chaque clic permet de doubler la vitesse 
de la recherche : x2, 4, 8, 16 et 32). 
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●●● Mise à jour du micrologiciel ●●● 
 
Le micrologiciel du LECTEUR sera mis à jour à tout moment en vue de la mise à jour 
des diverses performances et de la correction des défauts afin de satisfaire le client. 
Vous pouvez vérifier la version du micrologiciel dans le coin supérieur droit de l'écran 
SETUP (Configuration). 

1. La dernière version du micrologiciel peut être téléchargée sur www.zioncom.net. 
2. Après avoir connecté le LECTEUR à votre PC, copiez le micrologiciel à 

l’emplacement souhaité du disque dur. (Vous pouvez sauvegarder le micrologiciel sur 
un PC partagé). 

3. Branchez le LECTEUR à votre télévision et mettez l'appareil sous tension. 
4. Sélectionnez le fichier du micrologiciel en utilisant la télécommande et appuyez 

sur OK. 
 

 

1. Si l'écran d'avertissement du micrologiciel apparaît, lancez la mise à jour du 
micrologiciel en sélectionnant YES (oui). 
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Z 
2. La mise à jour du micrologiciel s'exécute. 
 

 
 

Lorsque la mise à jour du micrologiciel est terminée, le système va automatiquement 
redémarrer. 
Avertissement  
Lors du processus de mise à jour du micrologiciel, ne coupez pas l’alimentation 
et ne débranchez pas l’adaptateur. 
La dernière version du micrologiciel peut être téléchargée sur www.zioncom.net. 
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●●● Recherche des pannes ●●● 
 
.  
 
1. Lorsque l’appareil est sous tension, rien ne s’affiche à l’écran et on observe 
un effet de tremblement.  

 Lorsque le mode de sortie vidéo n’est pas correctement configuré, il se peut que 
rien n’apparaisse à l’écran, il peut être monochrome ou il peut s’accompagner 
d’un effet de tremblement. Appuyez légèrement sur la touche [TV OUT] (Sortie 
TV) de la télécommande et modifiez le mode de sortie jusqu’à ce que le mode de 
sortie vidéo soit correctement configuré. 
 

 Le lecteur est en mode PAL ou NTSC, vérifiez la sortie TV (NTSC/PAL).  
 
2. Lors de la lecture d’un fichier vidéo, les sous-titres n’apparaissent pas.  

 Si le nom d’un fichier vidéo ne correspond pas au nom du fichier de sous-titres, 
aucun sous-titre ne s'affiche.  
 

 En cas de sous-titres multiples, s’il n’existe pas de premier fichier de sous-titres, 
les sous-titres ne s’affichent pas. Dans ce cas, utilisez la touche [SUBTITLE] 
(Sous-titres) et sélectionnez le second fichier de sous-titres.  
 

3. Absence de sortie audio lors de la lecture d’un film.  
 Dans le menu SETUP (Configuration), vérifiez que le mode de sortie audio soit 

correctement configuré. 
 Vérifiez le niveau du volume sonore. 
 Vérifiez si la fonction [MUTE] (Sourdine) est activée. 

 
Pour de plus amples informations, veuillez consulter notre site Web 

www.mpmaneurope.com 
 


